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Whilst every attempt is made to ensure these manuals are accurate and current, Dedicated Micros reserve the 
right to alter or modify the specification of the machine described herein without prejudice.
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Introduction
How to Use the BX2 Continuous Archive
The following will describe how the BX2 Continuous Archive unit operates, installation and removing the drives 
and the LED functions that will describe the process of the ‘mirror’ functionality supported on the BX2.

The standard installation and configuration of the BX2 Continuous Archive unit is as described in the BX2 
Manual MI-I-BX2D/E1-0.

There are four removable drives in the BX2 Continuous Archive unit which can be accessed from the front 
panel. The drives are separated into two Primary and two Mirror drives. 

Unpacking
The BX2 Continuous Archive unit will be supplied with the necessary Primary and Mirror drives separately to the 
unit. 

These drives are labelled as C Primary and Mirror and E Primary and Mirror. Leave these labels in place to 
ensure the drives are always placed back into the correct locations.

Looking from the front of the BX2 Continuous Archive unit the C Primary and Mirror drives are to left of the unit, 
the other drives are the E Primary and Mirror drive. (See diagram below).

Warning: 	 The drives must be fitted in the correct bays, if they are placed in the wrong bay then the 
system will overwrite the discs and the unit will not boot up.

BX2 Continuous Archive Operation
Under normal operation the BX2 Continuous Archive will function as described below:

The BX2 Continuous Archive will write to both the Primary and Mirror drives, the read operation (review) is from 
the Primary drive. Mirror drives can be exchanged safely. The Primary drives should not be swapped.

If for any reason the BX2 Continuous Archive is unable to write to the Primary drive, the unit will assume that the 
drive is faulty and will switch the write process to the Mirror drive. The primary drive can then be changed.

If a new Mirror drive is introduced (e.g. original drive is removed for archiving) then the mirroring process will be 
activated, this ‘mirrors’ the video images stored on the Primary drive to the new Mirror drive. 
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Note: 	 All video files held on the Primary drive will be mirrored onto the new Mirror drive; this 
includes the files already on the drive that has been removed. This offers redundancy for 
these files.

To Access the Removable Caddies
The front panel of the BX2 has a latched door that will allow you to gain access to the removable caddies.

Release the door by gently pressing in until you here the release ‘click’, lower the door. You will see the 
removable drives; each one is locked in place and can be released using the keys provided.

The drives are separated into two sections with a Primary drive and Mirror drive in each section.

Archive Procedure
When the Primary discs are full or the recorded video needs to be archived, the normal procedure would be to 
remove both the Mirror discs. The record rate and the image size of the recorded files would dictate how often 
this would be required. The table below relates time period, file size and pictures per second.

		  600GB
168 Hrs	 14KB	 69pps
7 Days	 18KB	 53pps
	 25KB	 38pps

336 Hrs	 14KB	 34pps
14 Days	 18KB	 26pps
	 25KB	 19pps

744 Hrs	 14KB	 15pps
31 Days	 18KB	 12pps
	 25KB	 8pps

62 Days	 14KB	 7pps
(8 weeks)	 18KB	 6pps
	 25KB	 4pps

Example:

To be able to record for 8 weeks, the default settings of 18KB file size, with 6pps would be necessary.

These figures would change when MultiMode recording is used. Different conditions would result in a variety of 
file sizes and recording rates. Therefore these figures should be used as a rough guide. 

To archive the Mirror drive;

1.	 Set the Mirror device key to Off 
2.	 Remove the Mirror drive and store in a suitable Archive location
3.	 Replace with a blank Mirror disc
4.	 Turn the Mirror device key. The BX2 unit will start mirroring the existing data on the Primary disc to 

the mirror device as soon as the device is locked in place. 
Note: 	 Within 24 hours the unit will be fully synchronised.
The BX2 Continuous Archive unit will continue to record during this process and no images will be lost, you will 
be able to identify the mirroring process from the LEDs on the chassis for the removable caddies (refer to LED 
section below).
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Calculating When to Change the Mirror Discs
There is an alternative to changing the Mirror discs at set intervals. Using the Standard Record menu could 
allow the Administrator to view information on the BX2 and calculate if the disc is almost full.

1.	 For the initial disc change, use the recommended disc change guide.
2.	 Make a note of the time and date the discs were replaced.
3.	 Allow the Mirror process to commence. After a period of time (this is dependant on the number of 

system alarms), review the information on the Standard Record menu. 

Units PPS

Day

Night

Weekend

Image Size

Record Cameras

Maximum Record Time

Maximum Storage (Protected%)

Earliest unprotected recording

Edit

--Days  --Hours

0000GB(00%)

20/May/2006  23:55

Edit

006

006

00z6

Record
rate

Unchanged

Unchanged

Unchanged

Medium

Event
Mode

006

006

006

Event
rate

Both

Both

Both

18KB

Event
Active Disabled, Alarms,

Activity, Both
Disabled, Alarms,

Activity, Both
Disabled, Alarms,

Activity, Both

05-45KB

Exclusive,
Unchanged, Interleave

Exclusive,
Unchanged, Interleave

Exclusive,
Unchanged, Interleave

Standard Recording Schedule

4.	 Together with the time and date when the Mirror discs were replaced, review the information in 
the ‘Earliest unprotected recording’ section. This identifies the date of the first recorded file on 
the discs. Also view the Record Duration information. This will detail an estimate of the number of 
days and hours remaining before the recorded images on the hard disc will be overwritten. 	

	 Please note that there are a number of system features that can be used to trigger an alarm; 
importantly these include; Disk Low (an alarm trigger can be established to inform the User when 
the HDD is nearing capacity. The alarm will trigger when the disk usage reaches 90%). Disk Full. 
Disk Fault, Fault Archive (if the automatic archive process to either the internal CD/DVD writer or 
to an FTP server fails, the unit can be configured to use a failure notification as a zone trigger) and 
Slow Archive (will identify when the continuous archive process is slow and use an alarm trigger to 
help ensure that recorded images are not overwritten before being archived).

	 These features can be activated via Alarm Zone Configuration - Zone Settings - Zone Alarm Input 
- System menu.

	

Removing The Primary Disk
The normal archiving procedure involves exchanging Mirror drive. 

In the event of a Primary drive failure, this replacement procedure must be strictly adhered to:

Note: 	 The discs used in both the Primary and Mirror drives MUST be the same size.

1.	 Ensure the BX2 is in full mirrored state (This can be verified by a green LED on the removable 
caddy chassis - refer to How to Interpret the LED Status).

2.	 Unlock the Primary disc and remove the drive. The BX2 Continuous Archive will switch over and 
treat the Mirror disk as the ‘Primary’ drive. 

3.	 Replace the Primary drive with a new, blank drive. 
4.	 Insert the Primary drive and turn the key to lock. 
5.	 Press the Buzzer button once
6.	 The mirroring process will automatically occur. All data from the Mirror drive will be copied to the 

Primary drive. Once this is complete, normal mirroring is resumed.
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How to Interpret the LED Status

The installation, operation and configuration of the BX2 Continuous Archive is the same as detailed in the main 
manual, however the following details the information on the LED status information for the removable caddies.

There are three LEDs on the disc drive chassis, each of these LEDs has a state which can identify the status of 
the device and can be used for troubleshooting. 

Note: 	 If any LED status occurs other than what is detailed below contact Dedicated Micros Technical 
Support.

Primary LED
The left most LED is labelled PRIMARY and represents the disc in the ‘Primary’ (bottom) position. The centre 
LED is labelled MIRROR and represents the dis in the ‘Mirror’ (lower) position.

Primary (P) and Mirror (M) LED’s monitor status of the channels:
Solid Green 	 Drive installed on the current channel
Flashing Orange 	 Scanning the channel for drives
Solid Red 	 Drive not installed
Flashing Red 	 The Drive is marked as bad
Orange 	 Channel activity (read/write)

Status (S) LED shows the status of the EzRAID drive channel:
Solid Green 	 Drives are in Mirror mode, data is identical.
Flashing Green 	 Drives may not be identical
Solid Red 	 Drives are not in Mirror mode
Flashing Red 	 Copy/Compare is in progress
Orange 	 Copy/Compare in progress (under Windows)

The Buzzer provides the following indications:
• 	 Short beep during power on (system boot up) indicates successful EzRAID self test.
• 	 Second beep indicates the EzRAID is running in single mode.
• 	 Continuous or intermittent beep indicates a drive failure.
• 	 Depressing either select switch will silence the alarm.

Playback Process
The Mirror drive of the BX2 Continuous Archive unit can be removed from the unit and placed in a playback 
device (available from Dedicated Micros) for off line review of the recorded images.

Minimum Operating System Requirements
Windows 2000, Windows ME, Windows XP

Installing the Playback Software
The unit uses NetVu ObserVer to replay video. It is on the CD supplied with the product, and available as a free 
download from Dedicated micros Website. It should be installed on the PC that will be used to review the video. 

1.	 Insert the CD into the disc drive of the PC 
2.	 Run the Setup.exe file to install the playback software
3.	 Follow the on screen prompts to install the software
4.	 Enable the option to launch the software when Finish is selected
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Installing the Playback Device

Before installing the Playback device:
•	 Both Mirror drives should be removed from the BX2 Continuous Archive unit and be made 

available for review – video will be distributed across both drives, to ensure you review all the 
recordings you require both drives

•	 Full USB2 PC  – the playback device requires full USB2 connectivity, using a USB1 connection 
could result in failures.

•	 The PC is powered up and fully operational.

To view the contents of the mirror drive;
1.	 Place both Mirror drives in the Primary and Mirror slots on the playback device.
2.	 Connect to USB2.0 Input Device 1 on the unit and the USB2 port of the PC with the USB cable 

provided.
3.	 Connect main supply to the playback station.
4.	 Switch the unit on. 
5.	 The PC will identify the new hardware and will see the playback station as a new drives.

Note: 	 It is important that there are a minimum of two drive letters (between A – Z) available so the 
PC can automatically allocate the two Mirror drives a drive letter.

6.	 Using Windows explorer check that your PC has identified the two new drives 
 

 

7.	 Launch the Playback software previously installed.
Note: 	 The playback station should be powered off before restarting your PC.



Dedicated Micros ©2006�

C
on

ti
nu

ou
s 

A
rc

hi
ve

Viewing Stored Images
NetVu ObserVer is utilised to allow recorded images to be interrogated.

Select File -> Open Video.  Follow the on-screen menu sequence to locate and gain access to the stored video..

Note: 	 If a removable hard drive is to be reviewed, this must be connected prior to selecting this 
option.

When the stored video has been imported, the images will automatically be displayed. All cameras with 
associated video will be active in the site tree and can be individually selected for replay. Alternatively a 
multiscreen can be selected to review all cameras simultaneously.

Note: 	 If a multiscreen display is selected, choosing a camera for display will automatically display 
the consecutive cameras in the multiscreen.

Playback Mode Controls
In playback mode it is possible to use the VCR keys to control the images being reviewed.

There are a number of options available when playing back a video image;
English

Play - playback the video from the camera selected or highlighted an alarm file.
English

Pause - stop the video on a particular image.

When JPEG video is paused, the fast forward and rewind buttons operate as frame advance and rewind.

When paused in MPEG viewing, the fast forward and rewind buttons step between I-Frames.
English

Fast rewind - move quickly back through the recorded video
English

Fast forward - move quickly through the playback video.
English

Record - create a local copy of the image sequence currently on screen. Click on the button to open the 
submenu.

Note:	 This control is not available when the Remote Events List is displayed

English
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Directory - used to define where the recorded file will be saved

Filename - used to name the recorded file

Filename using local time - used to automatically name the file using the time on the local PC

Filename using UTC time - used to automatically name the file using the time zone specified as local on the unit 

Therefore if the unit is in a different time zone to the PC, the operator can select which time data to use.
English

It is possible to increase the speed of the video in playback mode. When fast forward or rewind have been 
selected, the speed of the video can be increased by up to 128 times the normal speed by selecting one of 
the options from the drop down list. The N mode will transmit at the fastest possible rate without dropping or 
skipping pictures, the speed of this mode will vary dependant on record rate and network transmission speed.

English
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Mousekey Sub functions
Right clicking on a playing camera, or on a live camera view in the viewer will open the zoom menu, allowing the 
user to alter the zoom level to 100%, 200%, 400% or 800%.

Right clicking on a paused image will enable additional functionality.

Save 	 This will allow a jpg in a user specified location. The dialog box also allows comments and a text 
file of the same name to be saved with the image.

Save as Reference 	 This allows a camera reference image to be saved for future comparison.
			   This can then be used for visual comparison to check camera positioning, or 	

		  when visibility is poor (fog, night) to identify features. 
			   The camera reference image is recalled by right clicking on the camera in the 	

		  site tree and selecting ‘View Reference Image’.
Print 			   This sends the paused image to the printer.

Note: 	 Saved / Printed images will have the time and date embedded in the title bar

English

Go To Time and Date
It is possible to review a specific video recording by selecting the time and date. Select the down arrow next the 
date window to display a calendar where the time and date can be selected.
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Enter the information and press OK. Any available video from the specified time and date will play.
English

Event List
The image server logs every event (as configured in the web configuration pages) to an event database. NetVu 
ObserVer can be used as the interface to access this database and allow the Operator to review the event list 
and any video recordings associated with the event.

When the Event List button is clicked, the event list for the image server will be displayed. An additional tab will 
also be added in the display window to allow the Operator to switch between the event list and live viewing.

English
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Note:	 The event list button is a latched button, when selected the event database for the server will 
be displayed, selecting again will switch the application back to view mode and remove the 
Event tab.
English

Selecting Refresh will refresh the event list.

English

Previous Event

English

Next Event

If an event has associated video recordings, highlighting and double clicking that event will automatically display 
the recorded images. Alarm text will be displayed in the title header of the image.

When the images are being reviewed the Live tab will be renamed as Replay so the Operator can tell the mode 
of operation. Click on the Events tab to return to the list of events.

The number of events shown on a single page is configured in the Tools -> Options menu of NetVu ObserVer.
English

Previous Page

English

Next Page

Using the previous and next buttons allows you to step through the pages of events.
English

Highlighting an event and selecting right mouse button will also allow the Operator to:

Refresh the Event List.

Get Previous 10, 50 or 100 Events.

Get Next 10, 50 or 100 Events.

Filter events by date, camera or alarm type.

English

Filter Events
It is possible to filter the event list by; text (if enabled), date, camera and alarm type using the Filter button in the 
right hand window.

Filter Text by typing the phrase or word required in the search box at the top. This will search for occurrences of 
the text in the text stream alongside the recorded video.

Filter by item & date using the drop down boxes to select a start and end parameter for the search. This will 
search for all events within the specified time period
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Filter by Camera by selecting the relevant camera. Right click to quickly select all. This will search the event list 
for events associated with the selected camera.

Filter by Alarm type by selecting GPS, VMD, Zone, System or All.

Press Apply at the bottom to begin the Filter.

It is possible to clear any filters from the event list by using the ‘Clear Filters’ button or the ‘Clear all filters’ option 
when the right mouse button is right clicked on the Event List.

When filter by date is selected it is possible to identify the start and end date including the start time.
English
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Activity
The unit provides the option to search the stored images for activity within defined areas, even if Activity 
detection was not enabled on the unit. Select the activity button on the Event screen to open the Activity filter.

A reference image is shown with a search grid superimposed. The default buttons below the image allow a quick 
selection of a quadrant of the image, the button on the upper left allows selection of an block by dragging with 
the mouse, and the button on the bottom right allows selection of individual search squares.

The Activity States options allows the user to specify whether the search is for ACT on, ACT off or ACT both.

ACT on		  Will search for when Activity starts
ACT off		  Will search for when Activity ends
ACT both	 Will search for when Activity starts and ends

English

The Activity Parameters are used to define which camera will be searched and the Camera Dwell Time. The 
Camera Dwell time is the amount of time the camera is static during a patrol.

English

English

English
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Download Images

It is possible to download all associated recorded images from the hard drive of the image server to the local PC 
(or a networked PC) from a specified time and date. These files can then be played back using NetVu ObserVer 
software, refer to Additional Features, Replay Server section for details on how this feature operates.

Note: 	 Although this option can be selected when controlling non NetVu Connected DVRs (Eco, DS2 
and BX2) this functionality is not supported and images can not be downloaded from these 
units.
English

There are two types of downloads;

                          Filtered                                                                   Raw

Clicking the download key will open the Download screen. You will need to identify the download method 
(filtered or raw), time and date (‘to’ and ‘from’),  the file name and location and if filtered was selected, which 
cameras that are to be downloaded (raw will download all cameras). 

Select Download to download the images, this process may take a some time depending on the size of the 
video segment selected and the network connection to the unit.

Note: 	 Selecting ‘Raw’ may require entry of the Username and Password if these have not been 
added in the configuration section of the image server for creating an FTP connections from 
the PC to the image server, default are dm and ftp.

View Menu Additional Functions

Embedded Data
Within NetVu ObserVer it is possible to display the embedded data for the cameras being viewed, this 
information gives details on camera name, camera number, activity detectors, time and date.

This information can be useful when evaluating the system or when contacting Dedicated Micros Technical 
Support.
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Note: 	 The number of pictures per second for the selected camera is also displayed in the bottom left 
of the embedded data panel. The content shown in this panel will depend on the preferences 
set in ‘Tools -> Options -> Behaviour -> ‘Show Download Statistics With Embedded Data’.
English

Embedded Text
NetVu ObserVer offers the option to monitor the text stream passing from a server used in a POS or ATM 
application. This Window will display any text being sent by the selected server.

English

Activity log
This window contains information commands sent to the video server as the viewer controls the device.

Note: 	 It is possible to configure the activity log to show different levels of messages. if problems 
are encountered whilst using the program, Technical Support may ask for debug mode to be 
selected for all messages to be visible.
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